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Introduction
Introduction
Quantrix Modeler version 4.1 is now available at www.quantrix.com. Users 
running version 3.7 and earlier can update their version of Quantrix 
via the Quantrix.com on-line store as Quantrix 4.1 will require a new 
download and running a new installation file. It is recommended to uninstall 
version 3.7 and earlier versions of Quantrix before installing Quantrix 4.1.
Users running version 4.0 are eligible for a free upgrade to Quantrix 
4.1. Quantrix 4.0 users can update their application via the Help > Update 
Quantrix mechanism. 

Caution:  Quantrix Modeler version 4.1 is not backward compatible. 
Any models created or modified in this version will not be readable by 
earlier versions (including version 4.0). If model files are shared throughout 
your organization, all users should migrate to the latest version at the same 
time.

This User Guide addendum is intended to highlight the new features, 
enhancements and fixes contained in version 4. Work is presently underway 
to integrate these changes into the PDF version of the Quantrix User Guide 
and through new on-line help systems currently under development.

Quantrix Qloud
With Quantrix 4, we are introducing a new thin client viewer application and 
server component called the Quantrix Qloud. Now, you will be able to 
upload Quantrix files to the Qloud server and share your models with select 
individuals or make a public link available that anyone can access. 

Caution:  The Quantrix Qloud is currently under active develop-
ment. Please be aware that from time to time we may need to reset all the 
files on the Qloud server as the code base develops. While security measures 
are in place we cannot guarantee the confidentiality of any files you publish 
to the Qloud during the development period. Please feel free to send 
feedback on the Qloud to support@quantrix.com.

The thin-client viewer eliminates the need for the user to install new 
software on their system. They can simply click on a link in an email you 
provide and open up the model in a standard web browser. The thin-client 
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Quantrix Qloud
viewer allows you to publish much bigger models than is possible with the 
HTML export. 

Note:  While Internet Explorer 8 and Safari 5 are supported, models on 
the Qloud are best viewed with Google Chrome 8 or Firefox 3.6

The initial release includes functionality to view Table Views only. Future 
enhancements that we are considering include the ability to view charts and 
canvasses, as well as allowing limited cell and formula interaction all in the 
thin client environment. We are also planning functionality to make the 
Qloud deployable on customers hosted servers within their network 
environment.

Qloud Access Levels

The number of models and model size is dependent on the type of Quantrix 
license you have.

• 30 Day Trial User: Can upload up to 5 models not more than 1MB 
each. Access to the Qloud is limited to your 30 day trial period.

• Quantrix Professional License: Can upload up to 5 models not 
more than 1 MB each. Access to the Qloud is good for one year post 
license activation. A subscription will be required after 1 year.

• Quantrix Professional Plus License: Can upload up to 10 models 
not more than 2MB each. Access to the Qloud is good for one year 
post license activation. A subscription will be required after 1 year.

If you or your organization need expanded Qloud access more than your 
license allows, please contact customerservice@quantrix.com for 
additional subscription options.

Using the Quantrix Qloud
Access to publish and administer models on the Qloud is located in the 
Web menu.
Quantrix Modeler User Guide
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Quantrix Qloud
Publish a Model to the Qloud
To publish a model to the Qloud choose Web > Publish to Qloud and do 
the following:

1. Enter the URL of the server the Qloud is hosted on. By default the 
Quantrix server will appear as http://publish.quantrix.com:8088/
qloudserver. You can change the default server via Tools > Options 
> Web. Click Next to continue.

2. Enter the Name, Description and Message for the model. 
Check the Make Model Public checkbox if you want the model 
to be publicly available. Click Next to continue.

3. Select the visible views and views initially open for the model.
• Visible Views - The views that can be accessed by the user via 

the thin client. If the box is not checked, the view will not be 
accessible.

• Views Initially Open - The views that are initially presented to 
the thin client users upon initial open.

• Click Next to continue.
4. To publish the model now, place a check in the box next to 

Publish to the Server on Finish. If publishing a model that has 
already been published to the Qloud, choose either Publish to the 
Same File on Server to publish and overwrite the existing file, or 
Publish to a New File on the Server to publish a brand new file 
on the server and generate a new URL. Click Finish.

5. You will be prompted to login with your username and password. 
If you do not have a username and password, click New Account 
and follow the on-screen prompts to set up your account.
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Quantrix Qloud
6. Once completed, you will be presented with a confirmation 
screen. Click Copy Link to copy the URL to the system clipboard. 
Click OK to dismiss the panel

Clearing the Publish Configuration
Once a model is published to the Qloud, the configuration can be cleared 
via Web > Clear Publish Configuration.
Quantrix Modeler User Guide
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Quantrix Qloud
Using and Sharing Models on the Qloud
Models that are public can be accessed by the direct URL generated during 
the publishing step. Models that are private require the user to create an 
account if necessary and login. 
To access the Qloud to view and administer models, choose Web > Qloud 
Portal... to go to the Qloud home page.

If you already have an account enter your Email and Password and click 
the Login button. Check the Stay logged in? box if you want your session 
to remain logged in when the browser is closed.

If you do not yet have an account on the Qloud, then click Sign Up and 
enter your desired login information. 
Once logged in, a list of the models previously published will appear.
Quantrix Modeler User Guide
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Quantrix Qloud
You can take the following actions for each model by selecting the model 
and clicking on the navigation link.

• Share - Share the model with specific users. Enter the email 
addresses of the users and optionally enter email addresses to be 
carbon copied (CC’d) and a personal message for the email body. 
Click Submit and the Qloud server will send out the email 
invitations.

• Open - Open the model in the thin client. Drag and drop the 
category tiles among the different axis. Double-click on the view 
names in the browser to open additional views. 

• Remove - To remove a model from the Qloud Server, select the 
model and click Remove. Click Yes on the delete model confirma-
tion panel.

• Show Details - To view the details of the model, click Show 
Details. Information such as name, created and updated dates, 
Quantrix Modeler User Guide
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Quantrix Scripting
description as well as sharing details are displayed. Click the Model is 
Public checkbox to turn off and on the model’s public status.

The Main navigation section of the Quantrix Qloud offers the following 
choices:

• Models - Display the list of models uploaded to your Qloud account.
• Account - Review your account details, subscription levels and reset 

your password.
• Quantrix Home - Access the Quantrix.com home page.
• Community - Access the Quantrix.com Community page
• Pricing - Request Qloud pricing information
• Help - Access Quantrix.com help resources
• Log Out - Log out of the Quantrix Qloud.

Quantrix Scripting
Quantrix 4 offers new scripting capabilities that enable you to automate 
tasks and expand its built-in computational facilities. Quantrix scripting is 
meant to be accessible to anyone who uses Quantrix regularly and wants to 
leverage the benefits scripting provides. You need not be a “professional” 
programmer to use scripting. Application of scripting does involve some 
programming, but only at a basic level. With mastery of just a few funda-
mentals, anyone can learn to write scripts.
To get started with Quantrix Scripting, please download the Introduction 
to Quantrix Scripting PDF guide found on the Quantrix.com scripting 
page at this URL:

http://www.quantrix.com/scripting.htm
Quantrix Modeler User Guide
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New Calculation Strategy
New Calculation Strategy

About the New Calculation Strategy
Quantrix 4 implements calculation engine changes to decrease calculation 
time and memory utilization while at the same time provids infrastructure 
for a multi-threaded calculation process in a future Quantrix release.
The 3.x calculation strategy does a cell by cell approach to determining 
which cells need to be calculated. With this strategy, most of the event time 
was taken up in the process of determining the cells that need calculation.
With Version 4, we have introduced a new range-based calculation 
approach. If one formula calculates many cells (as often is the case in a 
Quantrix model) this is referred to in the engine as a range of cells. Instead 
of individual cells, the new calculation strategy uses the range of cells to 
determine which areas of the model need calculation.
We are very encouraged with the results from internal testing and external 
customers. Calculation time improvements in the range of 25% to 80% are 
being reported. 
It is possible that this new strategy is not the best for all models. If a model 
has circular references, the previous calculation strategy is automatically 
used. If your models have long cell by cell recursion statements, you may not 
see a benefit to the new calculation strategy.
You can switch between the calculation strategies via Tools > Calculation 
> Calculation Settings. All models created and opened in 4.0 will default 
to the Range Based Strategy.
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Formulas, Functions & Cells
Formulas, Functions & Cells

URL in Formulas
Quantrix 4 allows for formulas to use URL web addresses to refer to 
Quantrix models in inter-model formulas. The syntax is as follows:

This formula refers to a web address to access a file called CashProjec-
tions.model. Then the values from the CashFlow matrix, Cash Change item 
are used in the current matrix.

Images and Hyperlinks in Cells

Hyperlinks

Matrix cells can now support hyperlinks to navigate inside and outside of 
the model.
There are three types of Hyperlinks:

• URL – link to a web page
• Location in Model – link to another location in the model (view or 

canvas)
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Formulas, Functions & Cells
• File – Link to an external file. The file will open in the external 
program (A PDF file would open in Adobe Reader)

To create a hyperlink in a cell, right-click on the cell and choose Hyperlink 
from the pop-up menu or choose Insert > Hyperlink. There is also a 
toolbar icon  to insert or edit a hyperlink. 
To delete a hyperlink, single-click on an area of the cell not controlled by the 
hyperlink and press the delete key.

Images in Cells

Matrix cells now support the ability to place images in the cells.
Images can be pulled from a URL or directly from the file system. If you 
store the picture with the model, the image will still appear if the URL goes 
off line. Please note storing images with the model will make the file size 
bigger.
To insert an image in a cell, right-click on the cell and choose Image from 
the pop-up menu or choose Insert > Image. There is also a toolbar icon 

 to insert or edit an image. You can also simply drag an image from 
outside of Quantrix into a matrix cell. 
To delete an image in a cell, single-click on an area of the cell not occupied 
by the image and press the delete key.
Any image inserted in the model will be stored in the image manager. You 
can access the manager via Tools > Images or by double-clicking on the 
image in the cell. From this manager, you can drag images to cells or to the 
presentation canvas.
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Formulas, Functions & Cells
New Functions
Quantrix 4 adds a variety of new functions to the function library.
 

Table a-1. New Quantrix 4 Functions

Description Function

Gives the number of days, months, weeks, or years between 
two dates. Possible values for interval are "d", "m", "y", 
"ym", "yd", and "md". "d", "m", and "y" give total days, 
months, or years, respectively. "yd" and "ym" give the number 
of days or months, respectively, if the dates are considered as 
being in the same year. "md" gives the number of days 
between the two dates if the dates are considered as being in 
the same month of the same year.

datedif (date1, date2, interval)

Returns (as a date) the last day of the month that is the 
indicated number of months after the start date. eomonth (start_date, months)

Gives the date some number of months after a given start 
date. If months is negative, this will yield a date before the 
start date.

edate (start_date, months)

Returns the least common multiple of two numbers. lcm (number1, number1)

Returns the greatest common divisor of two numbers. gcd (number1, number1)

Sums a finite geometric series with variable coefficents. The 
number of terms is given by the size of the coefficient list.

seriessum (base, initial_exponent, 
exponent_step, coefficients)

Generates a random integer greater than or equal to 
lower_bound and less than or equal to upper_bound. Returns 
a different number each time the model is recalculated.

randbetween (lower_bound, 
upper_bound)

Predicts an intermediate or future value along a trend, 
assuming the data fits an exponential curve of the form y = A 
* exp(B * x) (see also expa() and expb() to obtain the fitting 
used). If simple is present and true, this function will use 
simple linear regression on ln(y) = ln(A) + B * x. Otherwise, 
in order to avoid disproportionately weighting small y values, 
it will instead minimize the function sum(y_i * (ln(y_i) - ln(A) 
- B * x_i)^2).

expforecast (x, dependent_values, 
independent_values, [simple 
{boolean}])
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Formulas, Functions & Cells
Fit the values to a curve of the form y = A * exp(B * x), and 
return the B (this is typically used in conjuction with 
expa). If simple is present and true, this function will use 
simple linear regression on ln(y) = ln(A) + B * x. Otherwise, 
in order to avoid disproportionately weighting small y values, 
it will instead minimize the function sum(y_i * (ln(y_i) - ln(A) 
- B * x_i)^2).

expb (dependent_values, 
independent_values, [simple 
{boolean}])

Fit the values to a curve of the form y = A * exp(B * x), and 
return the A (this is typically used in conjuction with 
expb). If simple is present and true, this function will use 
simple linear regression on ln(y) = ln(A) + B * x. Otherwise, 
in order to avoid disproportionately weighting small y values, 
it will instead minimize the function sum(y_i * (ln(y_i) - ln(A) 
- B * x_i)^2).

expa (dependent_values, 
independent_values, [simple 
{boolean}])

Table a-1. New Quantrix 4 Functions

Description Function
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Data Management
Data Management

Login to Database as Different User
Quantrix 4 provides functionality to log into the database as a different user. 
When using an existing data source connection to a database in either 
DataLink, DataNAV or DataPush, click the Change User button to login 
to the data source as a different user.
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Data Management
Excel and Access 2010 Data Source
Setting up a data source for DataLink and DataNAV now supports Excel 
and Access 2010 files (.xlsx and .accdb). 

Setting UTF in CSV Export
In Quantrix 4, export to a delimited text file now allows for UTF setting for 
supporting foreign language characters. Choose File > Export > Delim-
ited Text File and set the UTF in the second export panel.
Quantrix Modeler User Guide
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Charting
Charting

Gradient Paints for Bar Charts
Quantrix 4 provides functionality to use gradient paints in Bar Chart for a 
more professional looking presentation.
To access gradient paint for bar charts, select the desired chart and in the 
Format Toolbox | Chart section click the checkbox for Gradient Effect.
Quantrix Modeler User Guide
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Model Management
Model Management

Model Management Enhancements
Quantrix 4 provides a variety of model management enhancements 
including:

• New Launch Panel Design - Quantrix redesigned the graphics for 
the Launch Panel and About screens as well as providing for a way to 
check for updates directly from the Launch Panel. Users can also see 
if they are running the 32bit or 64bit edition of Quantrix.

• Saved Perspective Save Defaults - When a perspective is saved via 
View > Perspectives > Saved Perspectives, the last perspective 
used will default as the saved perspective name.

• Full Screen Copy & Paste - When in full-screen mode via View > 
Full Screen, CTRL-C and CTRL-V will copy and paste cell data and 
objects.

• Model Browser Rename - Right clicking on an object in the model 
browser will give the user a Rename choice in the context menu.
Quantrix Modeler User Guide
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Presentation Canvas
Presentation Canvas

Canvas User Interface Changes
The presentation canvas toolbar now has new icons for images, shapes, 
scripts and snap alignments. There is also new functionality for aligning 
multiple objects on the canvas.

The new icon for Set Alignments  allows you to align multiple objects 
on the canvas at the same time. You align left, right, top, bottom, center-
vertical, center-horizontal. 
Simply select multiple objects on the canvas by shift-click or by by a click 
and drag, then choose the drop down arrow next to the icon to set the 
desired alignment.
When a canvas is in layout mode, a blue outline will be drawn on the canvas. 
This outline is another visual clue that you are in layout mode and any click 
and drag of an object will move the object instead of interact with the 
object.

Copy & Paste Sliders + Modify Cell Binding
Quantrix 4 provides functionality to copy and paste canvas sliders. Once 
copied, the slider cell binding can be changed to control a different cell.
To copy and paste a slider, do one of the following

• Activate the Layout button on the canvas toolbar.
• Click the slider and do CTRL-C on the keyboard or Edit > Copy 

from the menu
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Presentation Canvas
• Click anywhere on the canvas and do CTRL-V on the keyboard or 
Edit > Paste from the menu.

To change a slider cell binding follow these steps:
• Activate the Layout button on the canvas toolbar.
• Select the slider you want to edit the cell binding for.
• In the Format Toolbox, select the Binding section. In the text box 

provided, edit the cell reference to the desired cell.
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Problems Panel
Problems Panel
Now in one central location, you can view all the errors, warnings and other 
conditions in the model.

The Problems panel is accessed via Tools > Problems. Also, if you open a 
model with errors present, a banner will appear at the top of the model 
prompting you to open the errors panel.
Functionality in the Problems panel includes:

• Double-click on any error will bring you directly to the matrix and 
formula referenced.

• Right-click will offer an appropriate fix such as Insert Skips to fix 
eclipse conditions and Edit Formula to fix formula syntax errors.
Quantrix Modeler User Guide
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Other Fixes
• Click on the column headings to sort by level, description and 
location.

• Refresh the problem list at anytime via the Refresh button.

Other Fixes
Quantrix 4 incorporates many fixes to the code base. Many of the fixes and 
enhancements are the direct result of feedback from our users. Please 
contact support@quantrix.com if you need more information on any of 
these fixes.

Version 4.1
• Current heuristics for slicing/listing ranges in formulae are lacking
• Improve script action editing pane
• Create scripting menu
• Chart Legend losing saved location on canvas
• ScriptingLibs libraries are not accessible from within function sets.
• Autocomplete forces alphabetic sort since fife 1.5
• Autocomplete: Function and variable completion can be confused by 

comments and strings
• Autocomplete: Intuit method return types based on last line
• Autocomplete: Add support for Groovy ranges
• Autocomplete doesn't work for Groovy lists and maps
• Autocomplete doesn't handle Groovy-style Map access
• Autocomplete doesn't handle Groovy square bracket notation very 

well
• Autocomplete: Numbers and Strings don't coerce properly
• Autocomplete: Formula Selections don't autocomplete correctly
• Add autocomplete support for named parameters and varargs
• Bubble charts don't display negative sizes
• Add options to scripting console
• Autocomplete: Classes don't complete correctly
• Autocomplete for square bracket notation should look up methods 

by assignability, not by strict typing
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Other Fixes
• The Buy Button For a Trial User Shows Up in Wrong Place
• Value Labels Wrong on Pie Chart
• Use Special Matrices for Canvas
• Issue with ODBC Excel Connection Not Getting All Rows
• Update of Data Import with Repeating Column Names Problem
• Implement Toolbar Wrapping
• Filter Values > List still takes caps into consideration for sorting
• Remove dependency on SubxFloatingFrame
• Print Chart View Should Stretch Chart on Fit to Page
• Calculation Not Initiated on First Click
• Implement Expressions in Item Descriptors
• Font property editor does nothing for chart selection
• Calculation Strategy not retaining cell based strategy after save
• Dial Guage runs off the canvas when the Quantrix window is resized.
• OSX - Final pane of exporting delimited text file the text is cut off on 

right side of window
• DataLink Wizard window title is incorrect
• Launch Panel Quantrix Modeler title should have R not TM
• X and Y axis Title Expressions not updating properly as changes are 

made in the Format Toolbox
• International settings with German Separator creates Date entry 

problems
• Print Preview second print pulls in model Zoom %
• quantrix.ico - New ICO file with 32x32 and 16x16 file sizes
• Q_Icon update for corner of all windows
• Permission tab drop down menu not removing deleted roles
• Ctrl+Z won't undo a Chart Series change to a Line Chart Series
• Cannot Ctrl+Z to undo a Chart Type change without clicking on the 

cart window first
• Import window has the title of Open
• Model with Canvas Slider causing Quantrix to hang when opening
• Fresh Install w no prior Quantrix gives error during Setup
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Other Fixes
• OSX - Manage Roles dialog box cuts off buttons when roles are 
selected

• Item Descriptors menu option should be grayed out not removed 
from View menu when an item is not selected

• Web>Publish to Qloud menu item does not have "..." after Qloud in 
menu

• New OS X .icns set
• Improvement to quantrix-doc.ico file
• Note editing not working from Format Toolbox
• Preferences>International window cuts off drop down menu - OSX
• Help>Sample Models are not available unless a model is open
• File>New menu has a double list of identical templates
• View>Calculator list and Insert>Summary Item lists should show 

consistency
• Security>Create Role should have "..." after Create Role in Security 

Menu
• Format>Constrain Input window title wrong
• Standard Edition serial should have Security>Create Role unavailable
• In Chart View Ctrl+Arrow will only allow one movement of a 

category in a table
• Roles are losing default perspective if perspective name is edited
• View>Perspectives>Manage Perspectives window too narrow
• MIN and Value Function Interaction
• Improvements to Serial Number Activation panels
• Integrate new Help Jar into 4.0 app - PDF file
• Adding Items to Combo Chart reverts all Series to Bar
• The letter W causes Tab to Truncate
• DataLink CSV Data Type Error
• If canvas closed, adding items to matrix not updating view on Canvas
• Chart and Axis Titles Copying over each other
• Pie Chart Series Label Font Resolution Issues
• Using As not slicing correctly when Multiple Matrices are used
• Stacked Bar Labels need Improvement
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Other Fixes
• Add funcitonality to have a 'none' setting for chart bar outlines
• Scripting > New Keyboard Shortcuts
• DataPush & DataLink with Groups Same Matrix Rendezvous Issue
• Script Resize Window Issue
• Allow for Hyperlinks in Cells
• Scripting > New "Output" window
• Scripting > Auto-complete showing results when capitalization 

incorrect
• Clarify that Pipe script commands are "hard coded" strings only
• Axis should dissapear if all series are collapsed
• Undo of changing chart type not keeping format settings
• Chart Custom Tick Spacing - Maximum Issue
• Line Chart > Outline Color > Black cannot be chosen
• Add Keyboard Shortcut for Grouping
• Open a Script within a Tab
• Scripting > Better error message if what is entered between the pipes 

is not found.
• Scripting > Add Hide Empty Rows & Hide Empty Columns
• Scripting > model.autoCalculate=true does not set menu flag
• Scripting > model.save() does not take away * when issued with other 

script commands
• Excel Export - when categories on Filter tray produces incorrect 

export results
• New Language for QLoud Upload
• Add Cut, Copy and Paste to scripting
• Chart Filter Tray should keep Item Display when inserting chart on 

Canvas
• Box Whisker Chart Update Redraw Issue
• Auto-sizing a cell has a maximum height of 400 points
• List constraints with entries differing only in case has unexpected 

behaviour
• Center windows/dialogs in multiple-display environments
• Hid Items Indicator
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Other Fixes
Version 4.0
• New Splash Screen and Launch Panel Design
• Print Scaling A3 Paper size print issue
• Chart Axis Labels Print Quality Off
• Print Issues when not showing Matrix row header
• Full screen model - CTRL-V and CTRL-C do not work 
• Auto-resize not happening correctly. 
• Splash Pane Copywrite - Modify Year 
• Synch Views loss of focus 
• Filters on matrices not passed correctly to charts on creation 
• countif gives incorrect results with <> operator and incompatible 

types 
• Change text on Insert Chart to Canvas Tooltip 
• Extended Processor Spike when Rapidly moving canvas Slider 
• Undo of Cut/Paste does not restore notes 
• Disable "Show Currency" checkbox when Currency type selection is 

'None' 
• Alt-Tab losing Cell Focus 
• Note hover exposure too short 
• 2D WebServices Data Sources should resolve expressions in their 

parameters 
• OS X - Printing Large Bubble chart crashing app 
• Can't edit font and font size in page setup header 
• Radio Button does not save outline box size position 
• DataNAV - Can't change data type on newly created columns in CSV 

file 
• DataNAV - Add refresh option for JDBC and ODBC data source 
• DataNAV - Add ability to edit and remove custom fields 
• DataNAV - Update All Data Sources option 
• DataNAV - DataNAV category - All Values Format 
• DataNAV - Refresh ALL Option for Data Sources 
• DataNAV - Refresh should pick up New Columns in Database 
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Other Fixes
• DataNAV - Columnstore Date Field All Values Summary NULL 
• DataNAV - Linked Categories not respecting original qualifier when 

Data Item is present 
• DataNAV - Issue Linking a Category From Another Table in Same 

Data Source 
• DataNAV - New Name for Sum Product summarization method 
• DataNAV - Models created prior to copy/paste fix are in a bad state 
• DataNAV - Incompatible Expression Types Error using DataNAV 

Auto Summarize 
• DataNAV - Add Update All DataNAV Queries 
• DataNAV - Version Issue installing DataNAV stand-alone 
• DataNAV - CSV DataSource Wizard - Take out duplicate Encoding 

text 
• DataNAV - Can't change Data Type when editing Data Source 
• DataNAV - Covariance summary method not correct 
• DataPush - Version issue installing DataPush stand-alone 
• DataPush - Custom field value types 
• DataPush - Blank Constant Custom Field errors when Log File On 
• DataPush - DataPush on Save needs Progress Panel 
• DataPush - Make Pre-Post SQL interior panels resizable vertically 
• DataPush - Add Two Columns Presents Error Message 
• DataPush - Issue pushing NOW() into Date-Time column in SQL 

Server 
• DataPush - Oracle DataPush dropping data 
• DataPush - Introduce Datapush permissions tied to roles 
• Now have an option to check for updates from the Launch Panel
• Slider font size not saving with the model 
• Exception Thrown When Opening Models in Multi-Threaded 

environment 
• Canvas Text Expression not keeping Format 
• Constrained Input Tab Auto-Complete Issue 
• Groups in Chart Grid Row Axis causing Print Issues 
• Conditional Format - non english Locale issues 
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Other Fixes
• Unlink Category changes Canvas View category position 
• Outline Collapse Alignment Issue 
• Collapse all items within group - cannot double-click to uncollapse 
• Chart Grid changing scale when snapped table view is sorted 
• Quantrix Menu - Chinese Font Issue 
• Some Asian Fonts not working in 3.7 
• Error stack trace when entering cell values due to hide empty rows 

columns 
• minute() and second() functions round incorrectly on manually 

entered dates/times 
• Calculation involving 'using as' doesn't always proceed 
• Canvas Point Snaps losing item and cell border lines 
• Open Model Browser Permission not working 
• Invalid Permission Message changing value on Canvas 
• Added new functions to the function library 
• Add ability to copy / paste slider with settings & change cell pointer 
• Add ability to edit slider binding cell reference 
• With matrix view embedded in canvas - show matrix name as read 

only property 
• Make Full Screen a Menu Item 
• Allow user to set UTF in CSV export 
• Manage Roles dialog box re-size error 
• Tool Tip mislabel in Print Header / Footer 
• Constrained Input Cat List Exclude Summary Item Option 
• Add Image canvas toolbar button should be off while in Interaction 

mode 
• Easier way to identify binding references 
• Make it easier to add and delete multiple driver versions  
• Model Document Releases Lock After Exception is Thrown 
• Take out IBM patent language from License Agreement 
• Quantrix Server public link not working 
• Formula Hopping after Copy and Paste 
• Undo of Item Name change | Constrained Input | Calculation Issue 
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Other Fixes
• Change Alphabetical Sorting across entire app 
• Save Perspective default to the open perspective name 
• Setting UTF-16 on DataLink csv file taking long time 
• Make toggling between interaction mode and layout mode easier 
• Chart Copy to Clipboard results in small image 
• The x icon for the Insert Items dialog acts as OK button, when it 

should act as cancel 
• OS X - Constrained Input OK Dialog Panel Issue 
• OS X - difficulty setting decimal constrained inpu 
• Add Access 2007 and Excel 2010 and Access 2010 to list of ODBC 

Connections 
• Default to Java Look And Feel 
• Help > About Screen offer more info on Plugin Versions 
• Use Gradient Paints for Bar Charts and other appropriate charts 
• Add right-click Model Browser Matrix Rename Option 
• Add ability to login to DB as a different user 
• Automatically take the lock if the same user access a locked file
• Sort Matrix Names in Two-Dimensional DataLink Import 
• Add Insert Image toolbar icon for Presentation Canvas 
• Scroll Format Toolbox when opening section 
• Allow formula expressions to reference other models specified by 

URL 
• Shift - CMD - s should invoke Save-as on OS X 
• Close all views shortcut command (CTRL-H) 
• Constrained Input List Should Have Group Name 
• Allow number format on slider controls 
• Add XNPV and XIRR to function libarary 
• Add ability to collapse items when category is in filter tray 
• Find and Replace - Progress Panel 
• Group Item Rename Issue 
• Group Format Issue 
• DataLink - Specifying Date Format on Category causes UI Freeze 
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Other Fixes
• IF & OR causes Dependency Inspector duplication 
• Error Message - Registered object being read, but no factory name 

on file 
• Category Not Cleaned up after Delete 
• When using QAPI to set bulk values, SubxRepaintManager leaks 

memory 
• Problems With Writing DOM Objects if Orignal object deleted 
• Zoomed Canvas Page Breaks not remembering paper size 
• Chart Axis Re-draw issues after rapid scrolling 
• DataLink - Item Descriptors not getting blanked out on NULL 

import values 
• Error Opening File with DataPush Configuration 
• skip column in text datalink not working correctly. 
• integer cell constraint error message a bit misleading 
• Can Access Locked Matrices Through DataLink 
• Exception Creating DataLink with Views Hidden 
• Spaces stripped from table name when used in conditional 

formatting 
• copying matricies with collapsed groups into excel has issues 
• Cancel Does not cancel Update Links 
• matrix focus not set correctly when linking categories using CTRL + 

drag 
• using F2 to edit chart/table view names causes the matrix name to 

appear in the edit field
• Error on XML Import on Windows7 When Not Administrator 
• Sum Toolbar not displaying large numbers correctly 
• Highlighting text in Select Function dialog closes formula for edit
• Datalink No Summary Rendezvous Problems 
• typo in message when entering invalid value into decimal constraint 
• better error message when updating a data link that returns no results 
• DataLink: When Switching Summary Type, Get New Name 
• line format arrow heads not shown when control is active & style is 

set 
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Other Fixes
• Typo in the Edit Menu of the Spreadsheet 
• overriding Quantrix window listener causes occasional problems 

when cell is in edit mode. 
• cannot call QExpression.evaluate(QCell) from within CellVisitor 
• Column Alignment Issue When Copy Group and Paste HTML 
• ChartType Instances Shared Between Charts 
• A3 paper size not honoured when printing 
• QAPI Functions Cause Model to Open With Permission Problems
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Other Fixes
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Other Fixes
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